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CHAPTER 12. COLOR

Chapter 13

Image-Processing Using Photoshop
and Other Tools
[Of the lost detail in the darkest and lightest areas of a photograph due to the limited dynamic range of photographic ﬁlm]: “strong shadows swallow up all timid lights
within them, as her blazing lights obliterate all intrustive halftones across; and thus
strong contrasts are produced, which, so far from being true to Nature, it seems one of
Nature’s most beautiful provisions to prevent.”
— Lady Elizabeth Eastlake in her essay “Photography”, London Quarterly Review, pgs. 442–468 (1857); reprinted in Classic Essays on Photography, ed. by
Alan Trachtenberg (ed.), Leete’s Books, New Haven (1980).

13.1

Introduction: Scientiﬁc Applications of Photoshop and
Other Image-Processing Tools

1. Text, arrow, and other annotations of photographs.
2. Deleting unwanted background elements from photographs or scans.
3. Removing “stray light” damage from scans of books, journals or xerox copies.
4. Decolorizing a photo so as to create a black-and-white image that is cheap to
publish.
5. Contrast enhancement.
6. Inverting images
7. Reducing the bits/pixel to make Web-publishable graphs.

13.2

Annotated Photo

Fig. 13.1 is a picture of Mars, taken on December 11, 1999 from the Mars Global Surveyor
in orbit around the planet. For more than a year, the science team had noticed lots
and lots of dark streaks on the planet’s surface. It is known that dust devils, which
are miniature tornados made visible by entrained dust, are very common on Mars.
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The desert-like conditions create convective instability; with even a modest amount
of horizontal shear in the wind, the convective plumes can spin up into concentrated
whirlwinds. But were dust devils really responsible for the streaks?
The ﬁgure answered their questions. The bright patch is a dust devil, photographed
from almost directly above. The shadow shows its true columnar shape and the dark
curve to the right of the dust devil is exactly the kind of streak that had been seen so
often in earlier photographs.
However, without arrows and captions, the photograph is gibberish. The Mars Camera Science Team knew that, seen directly above from orbit, a whirling column of dust
would look like a bright streak, but this is hardly obvious to the casual observer. Similar,
the shadow is hard to tell from the streak. Only because this photograph was annotated by the Science Team using both arrows and text does the photograph become
comprehensible. One can then immediately identify the key features and concentrate
on the crucial question: Is the Science Team’s interpretation reasonable?

Figure 13.1: Annotated photograph of the Promethei Terra region of Mars, taken from
Mars Global Surveyor. The dust devil is less than 100 meters (less than 100 yards) wide
and the picture covers an area approximately (about 1 by 1 mile). The text annotations
are by the Mars Science Team. The image was opened in Photoshop and cropped to a
width of 1.3 km and height of 1 km from its original 1.5 by 1.7 kilometers size; the scale
was moved to ﬁt within the cropped image. Mars Orbit Camera (MOC) Team: M. C. Malin,
K. S. Edgett, M. H. Carr, G. E. Danielson, M. E. Davies, W. K. Hartmann, A. P. Ingersoll,
P. B. James, H. Masursky, A. S. McEwen, L. A. Soderblom, P. Thomas, J. Veverka, M. A.
Caplinger, M. A. Ravine, T. A. Soulanille, and J. L. Warren, NASA’s Planetary Photojournal
(http://photojournal.jpl.nasa.gov/), MOC2-220-C.

13.3

Before and After Scientiﬁc Photos

Fig. 13.2 illustrates a cutaway of the earth’s interior temperature which was made with
a rather garish black background. It is easy to cut away the black in Photoshop. The
“elliptical selection marquee” can be constrained to be a circle by holding down the shift
key; it can be constrained to draw from the center of the globe by starting the drag at
that point while holding down the Option key. The selection can then be inverted to
select everything outside the globe by going to the Select menu and choosing Inverse.
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Thus, the background outside the circle can be deleted in about thirty seconds, but
the maneuver is so easy only because Photoshop has powerful selection tools (circle,
draw-from-center, inverse).

13.3.1

Removing Unwanted or Irrelevant Graphical Elements

Figure 13.2: Cross-section from the outer mantle to the inner core. Blue areas are cold,
dense, and transmit seismic waves at relatively high speeds. Red regions are hot and
light. Plot generated by Adam Dziewonski and John Woodhouse.

318

CHAPTER 13. IMAGE-PROCESSING USING PHOTOSHOP AND OTHER TOOLS

Figure 13.3: Same as previous ﬁgure but with the black background exorcised in Photoshop.
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Figure 13.4: A photograph taken through the Isaac Newton Telescope in the Canary
Islands, showing a 1.5 million kilometer string of nuclei of Comet Shoemaker-Levy, 15
May ’94, two months before its collision with Jupiter. (M. Irwin, A. Fitzsimmons and I.
P. Williams).
Fig. 13.4 shows a telescope photo of Comet Shoemaker-Levy. Like most astronomical
photographs, the raw image includes a vast amount of extraneous detail including many
background stars. The simpliﬁed image was produced by
• Using the polygonal select to delete two large wedges of extraneous material.
• Selecting and then rotating the remaining image.
• Cropping the image using the crop tool, which is similar to the rectangular selec-

tion marquee (and can be obtained from it by dragging on the selection marquee
item in the tool menu).
• Rubber stamping to eliminate some remaining disks that are clearly background

stars.
• The contrast was moderately enhanced using a Contrast/Brightness Adjustment

Layer.
Rubber-stamping has to be applied carefully; one should only eliminate elements
that are clearly extraneous.
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Figure 13.5: Same as previous ﬁgure except that extraneous parts of the image have
been cut away, a few background stars have been removed by rubber-stamping, and
the contrast was slightly enhanced.

Figure 13.6: Same as previous ﬁgure except that black-and-white were inverted. The
original image had a histogram that included only the upper half of tonal values. This
was changed using an Adjustment Layer/Levels, and then the image made into a negative image through Adjustment Layer/Inverse.

Figure 13.7:
Same as the previous negative image, but with Adjustment
Layer/Threshold, which stores 1 bit per pixel. File size was reduced from 284 kilobytes to 95 kilobytes (EPS ﬁles). However, the tubular tail that extends from the leading
nucleus back through the trailing fragments has been eliminated by thresholding. This
image is good if one is focusing on nuclei, but disastrous if one wants to investigate
the tail!
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Removing “Stray Light” Damage

Fig. 13.8 shows the result of xeroxing a page of graphs from an ancient journal and then
scanning. It is difﬁcult to get good quality xeroxes of pages from a journal because it is
impossible to close the cover of the xerox machine. A useful procedure in reducing the
amount of stray light is to lay sheets of blank paper or other journal volumes on top
of the glass next to the “target”. When the glass is completely covered, the amount of
stray light reaching the xerox detector is reduced. If the xerox machine is near a wall, it
may be impossible to completely block the wall side. The result is a xerox (and ensuing
scan) which are contaminated by large blotches that are the image of stray light.
Photoshop is a good vehicle for removing the “stray light” damage because the damage can be simply erased. In cleaning up this ﬁgure, the “polygon-lasso” tool is quite
helpful because one can click straight lines to bound the rather irregularly shaped
blotches. The “magic wind” is not helpful because the entire image is black, so magic
wand selects both the graphs and the noise. The ordinary “lasso” can be used, too, but
it is slower because one must manually draw lines nearly parallel to the top and bottom
of the page. The eraser is very useful for eliminating blotches that overlap lines of the
graph, and thus have to be removed very carefully. Because the eraser has a “brushes”
palette available, one can choose various eraser sizes as one works.

13.3.3

Contrast Enhancement

Fig. 13.10 shows a photograph from a ﬂuid mechanics laboratory experiment. The
contrast between the yellow-tinged vortices and the ambient reddish ﬂuid is very poor.
So, we enhanced this ﬁgure in Photoshop in the following ways:
• The black wedges in the corner and the outer wall of the tank were eliminated

by using the elliptical selection marquee with Shift held down (to constrain it to
a circle) and also Option held down (to draw from the center of the tank); the
spacebar was held down to allow a slight adjustment of the center of the circle.
Finally Select > Inverse was used to select the exterior of a circle centered on the
tank, and this exterior was deleted.
• The contrast was enhanced by creating a new Adjustment Layer in the Layer menu,

choosing the type of the new layer to be Brightness/Contrast and then adjusting
these until the image seemed much clearer. (Adjustment Layer changes are previewed, but not actually applied to the image until “OK” is clicked.)
• The red color was replaced by ﬁrst selecting the entire image, then Image > Adjust

> Replace Color. This brings up a dialog box with a preview area and three eyedroppers. By clicking on the left eyedropper, one can pick a color to be replaced.
The middle eyedropper (labeled with a plus sign) can be dragged to add more and
more regions of color; the selected areas will be displyaed in white in the preview
box. One can then choose a new color to replace the old by dragging sliders that
are also in the Color Replace dialog box. The red background of zero vorticity was
replaced by blue.
• The rubber stamp was used to replace the black photoguide disks by ambient

colors. The black disks in the blue regions, for example, were replaced by Optionclick on a blue region and then clicking on top of a black disk. A black disk that
intruded on a region of yellow streaked with a little orange was replaced by three
bands of yellow, orange and yellow by using the rubber stamp with a smaller
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Figure 13.8: Scan of a collection of ﬁgures from an 1882 article by Henry M. Jeffrey, F.
R. S. The scan was made from a xerox. Unfortunately, the xerox was contaminated by a
lot of stray light because the fragile pages of the more-than-a-century old journal could
not be easily manipulated without damaging them. The “stray light” damage was ﬁxed
in Photoshop as shown in the next ﬁgure. This ﬁgure is some interest independent of
the stray light. First, Jeffrey’s article contained some 84 numbered ﬁgures; even in the
19th century, it was possible to use graphics extensively. Second, the ﬁgure shows how
many graphs can be combined into a single page without loss of clarity, especially for
line art. Third, the absence of captions is bad because the reader has to jump constantly
between the text and the page with graphs. Fourth, in order to facilitate comparisons
between different graphs printed on the same page and perhaps also to reduce the cost
of the special printing plates for the graphs, the ﬁgures were printed on fold-out pages.
These opened up to create pages much larger than the digest-size pages of the rest
of the journal. Because all the graphs were crammed onto foldouts, individual ﬁgure
captions had to be sacriﬁced.
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Figure 13.9: Same as previous ﬁgure except that the xerox imperfections have been
erased using Photoshop.
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Figure 13.10: Scanned from a photograph of a laboratory ﬂuid tank experiment by
Harry Swinney of the University of Texas and collaborators. The yellow patches are
vortices; the complete sequence of photos from which this has been taken illustrates
the formation of vortices in a shear zone in a tank which is rotating on a turntable, and
the subsequent merger of these vortices. The black disks are aids to the measurement
of ﬂow properties as the tank rotates and a camera and/or video camera photographs
the tank from above.
brush size. Finally, the “stamped” areas were blended more smoothly into their
background by applying the “smudge” tool.
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Figure 13.11: Same as previous ﬁgure, but “improved” in Photoshop
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Decolorization

Fig. 13.12 shows a photograph of a laboratory experiment on the collision of two pairs of
contra-rotating vortices. If one wanted to publish this photograph in black-and-white,
such as would be useful in a theory paper that purported to explain these experiments,
how could one do it?
Fig. 13.13 shows the result of converting the color image to a grayscale image. The
grayscale image is not entirely successful. The contrast between shades of gray makes it
difﬁcult to see the green/orange differences of the original photograph — unfortunate
since the colors indicated the origin of the vortices, which have exchanged partners by
the time of this post-collision photograph. (In other words, the two green vortices have
split up, each leaving the collision with a vortex of opposite sense of rotation from the
other vortex pair, which was dyed orange.)

Figure 13.12: Colliding vortex pairs (modons) in a laboratory experiment by GertJan van
Heijst and Jan-Bert Flor, published as Plate 18 by Ball(1999). The image was scanned
from a photograph of the rotating tank; green and orange ﬂuorescent dyes were used to
mark each of the two initial vortex pairs, which have collided and exchanged partners
at the time shown.
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Figure 13.13: Same as previous ﬁgure, but converted to a grayscale image in Photoshop.
The Trace Contour option was used to provide a black border around the main features
of the vortex.

328

CHAPTER 13. IMAGE-PROCESSING USING PHOTOSHOP AND OTHER TOOLS

13.4

The Manipulated Photograph

A photo has always been regarded as strong evidence because “photos do not lie”. No
professional photographer has ever believed this. In reality, photographs have manipulated visual reality from the very earliest experiments of Daguerre and Fox Talbot in
the 1830’s.
One difﬁculty is that to quote Michell(1992): “the range of intensities in a visual ﬁeld
will often be very much greater than the range of tones than be captured and presented
by a photograph. Pigments, inks and dyes can yield a ratio of tonal values, from darkest
to lightest, of about forty to one, bu the ratio from deep shadow to sparkling highlights
in a sunlit ﬁeld can be thousands to one. Thus the photographer must compress the
intensity range of the scene with inevitable distortions and loss of detail”.
The perceived intensity of sound and light and other stimuli may not appear to
have such a huge reason. However, human senses operate on a logarithmic scale, a fact
which is known in physiology as Weber’s Law.
Photographers have developed a wide variety of strategies to cope with image problems. Deliberate overexposure or underexposure of an image is obvious. However,
selective adjustments to parts of an image, known as “dodging” and “burning”, were
developed in the nineteenth century. This eventually became elaborated into the Zone
System, popularized by Ansel Adams, Minor White and other well-known photographers. “Dodge” and “burn” are two of the tools in Photoshop.
Colored ﬁlters are popular with photographers, too. Yellow ﬁlters are used to darken
skies and bring out the detail of clouds. Red ﬁlters lighten foliage while also darkening skies even more than yellow ﬁlters. To dramatize building forms, architectural
photographers have long been fond of covering their lenses with a red ﬁlter.
It is sometimes helpful to adjust the tone values of an entire image by either brightening or darkening. The “Claude glass” was a popular eighteenth century ﬁlter for
darkening the view, which seems to make landscapes look more harmonious.
Photoshop allows one to dodge and burn, color ﬁlter, apply a Claude glass, and
a wide range of other color and tone adjustments far more easily, and with far ﬁner
control, than similar adjustments with ﬁlm and developer. Many of these adjustments
are merely cosmetic, and therefore much more important to the photojournalist than
to the photoengineer.

13.5

Common Boo-Boos

• When a tool fails to work, it is probably because one is in a different layer than

one thinks.
• Another reason for tool failure is that the previous selection is still operating. One

must make frequent of Deselect, which is an item under the Select menu, or the
keyboard shortcut Apple-D.
• When the Save menu does not allow an option such as Photoshop EPS, it is probably

because the ﬁle needs to be ﬂattened, that is, have all the layers combined into
one, in order to be saved in EPS, or any other format that does not support layers.

13.6. ALPHA CHANNEL

13.6
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Alpha Channel

Full-color RGB image ﬁles use 24 bits/pixel: 8 bits to specify 256 different intensity
levels for each of the three additive colors. However, graphic designers found that
this was not enough. What if one wanted to specify transparency properties, or other
non-color properties at each pixel?
Some ﬁle formats, such as TIFF, Pict, and PNG, therefore support an “alpha channel”.
This optional feature of a ﬁle is a place to store transparency information, etc. The
concept of an “alpha channel” is a little bit fuzzy because there are potentially a lot of
different additional properties that might be appended to a graphic ﬁle.
Adobe Photoshop allows a lot of alpha channels; some ﬁle formats support only one
such channel. In any event, an alpha channel is a place to store properties of the pixels
other than intensity-of-each-color.

13.7

Delayed Execution, History and All That

It is easy to reverse the drawing of a line in vector graphics simply by deleting the line.
Reversion is more difﬁcult in image processing because allowed operations include
blending old and new colors together, diffusing features, and so. Blending and diffusion
are much harder to cleanly reverse than the addition of a vector-graphics feature.
For this reason, “delayed execution” is a major theme in image-processing. Good
software allows one to do all sorts of operations without changing the underlying image
so that one can revert to an earlier state of the image.
Adobe Photoshop offers a rather bewildering array of tools for delay. Some important ones include the following:
1. layer masks
2. adjustment layers
3. history palette
4. history brush

13.7.1

Layer Masks

Artists often cut shapes out of paper or a material called “frisket” and fasten them
to an illustration to block parts of the picture from the spray of an airbrush. Imageprocessing programs make it even easier to apply masks to conﬁne various operations
of painting, lightening, etc., to selected portions of the ﬁgure only.
Frequently, one only wants to apply adjustments to a portion of the image. For
example, a ﬂash photo may contain a picture of a person that is very bright (because the
light from the ﬂash could illuminate the subject) against a background that is extremely
dark (because it was too far from the ﬂash to be illuminated). One can create a layer
mask by using all the standard painting tools to layer the label with white, black, or
gray to indicate which pixels should allow an effect, prohibit an effect, or allow the
pixel to average the effect with the original state of the pixel. Once the mask has been
created, one can then apply effects with wild abandon only to the chosen area.
The alternative is to draw a selection border on the image and then apply the effect
within the border. The trouble is that if the change needs to be altered later — coloring
the sky a dark blue may need to be modiﬁed by adding in some clouds, for example
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— then one has to painstakingly draw the selection border all over again. However, a
layer mask is a permanent feature of the illustration, saved as part of the ﬁle whenever
the image is saved in Photoshop format. One can apply, or not apply, a given layer
mask very easily at any stage. The layer mask indeﬁnitely delays the destruction of a
selection border.

13.7.2

Adjustment Layers

Adjustments to brightness and constrast, saturation and hue, etc., can be made directly
to the image, but are not easily unmade. One can alternatively perform these same
operations in a “layer mask”. The advantage is that the change can then be unmade
simply by deleting the layer. Furthermore, one can return to the layer at a later time to
tweak the adjustments.
The adjustments are never closed, but are like a layer of paint that is allowed to
remain indeﬁnitely wet.

13.7.3

History Palette

This feature shows the names and snapshots of the last 20 graphical operations. (Changes
to global preferences are not shown, but almost everything else is; the number of operations kept as “history” can be changed by the user, if the computer has enough memory
to support a large number of “history” snapshots.)
By dragging items in the history palette to the little trash icon underneath the history
palette, one can delete graphic operations that were not a success. In normal operation,
deletion of a state also deletes all later states. However, at the expense of a little more
memory and more thinking by the software, one can check an option called “Allow
Nonlinear History”. When an operation in the middle of the “history” is deleted, only
that operation goes away.

13.7.4

Snapshots

One may explicitly save an intermediate image state as a “snapshot” so that it will
appear permanently in the history palette with its own name. This can provide a convenient visual anchor when doing (or undoing!) a complicated set of operations.

13.7.5

History Brush

Instead of brushing on strokes of a color, the history brush allows one to create by
brushing sections where the image reverts to a previous state or snapshot. Thus, if
one brightens the dark background of an image, and accidentally got some foreground
pixels, one could use the history brush to revert those foreground pixels to their original
state.
Alternatively, one can also apply the eraser with “Erase to history” option turned
on. This reverts the chosen parts of the image to their appearance in the last SAVED
version of the ﬁle.

13.8

Paths

Vector-graphics instructions, such as the walls of a polygon, are sometimes called
“paths” in software manual. Photoshop allows one to draw “paths” using the pen tool
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and its variants. The pen operates almost exactly as in Illustrator; it creates a curve
controlled by Bezier polynomials. By using tools under the pen tool, one can and delete
anchor points, move segments bounded by two anchor points, move the direction arrows that radiate from anchor points and so on.
Paths can be used in two very different ways. First, just as in a drawing programs,
paths can be given a “stroke” (the color/linewidth, etc. of the curve that deﬁnes the
path) plus a “ﬁll”, which is a color, color gradient or texture that ﬁlls the interior of the
path. This use is simply a way to add vector-graphics items to a bitmap image.
The second use is that paths can be converted to selection borders. (Click the little
triangle on the right of the “paths” palette to bring up a menu of options.) This allows
one to draw very intricate selection borders, just the way you want them, when the
square and elliptical selection marquees and the pixel-edge selection tools are inadequate.

13.9

Transformations

Just as in vector graphics, one can select an area of an image and apply rotation, shear,
dilation, and other transformations to the selected block of pixels. Indeed, Photoshop
has some three-dimensional transformations which can be very useful in modifying
photographs of real, three-dimensional objects. Because of the similarity of these transformations to those in Illustrator and other drawing programs, these transformations
will not be discussed in detail.

13.10

Organizing Images: Contact Sheets

A “contact sheet” is a collection of miniature images, all on a single page, which illustrates all the images in a single roll of ﬁlm. Such contact sheets are very helpful in
organizing graphics ﬁles because the thumbnail sketches allow one to easily identify a
desired picture when the ﬁlenames alone are inadequate.
Photoshop has a command (under the Automate command under the leftmost main
menu) which will automatically make a contact sheet showing all pictures in a given
folder or subfolder. An example is shown in Fig. 13.14
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Figure 13.14: Contact sheet generated by Photoshop.

